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EC250 Laboratory Project #2 

PN Junction Diode Modeling 
Team Members:________________   ___________________ 

Date Performed: _______________    Lab Station #: _______ 

 
Parts needed: 1N4148 small-signal (small glass package) diode, 1N4004 power diode, red LED, 

three 1 kΩ resistors, breadboard, wire strippers, hookup wire. 

Prelab Work:  Please complete the requested formula derivation and also the simulated test data 

analysis required on p. 3 before coming to the laboratory.  (See Appendix A for a review of using 

Microsoft Excel to plot data and fit the plot to a straight line.) 

 

1.  The pn junction diode as a "unidirectional flow valve" 
Connect a small-signal 1N4148 diode in series with a 1 kΩ resistor and a 5 V dc power supply, 

as shown in Fig. 1.  Begin by connecting the “bar" end of the diode package to the (-) terminal of 

the 5 V supply.  Measure the voltage across the diode (Vd) and the voltage across the resistor 

(Vr), the sum of these two readings better equal 5.0 V.  Indicate whether the diode is “forward-

biased” or “reverse-biased”.  Now reverse the power supply terminals and again measure Vd and 

Vr.  Repeat for the 1N4004 power diode and a red LED: 

 

 1N4148 small signal diode with “bar” end connected to (-) terminal of 5 V supply: 

 

   Vd = _________    Vr = _________    Fwd or Reverse Bias_____ 

 

 1N4148 small signal diode with bar end connected to (+) terminal of 5 V supply. 

 

   Vd = _________     Vr = _________   Fwd or Reverse Bias_____ 

 

 1N4004 power diode with bar end connected to (-) terminal of 5 V supply: 

 

   Vd = _________    Vr = _________   Fwd or Reverse Bias_____ 

 

 1N4004 power diode with bar end connected to (+) terminal of 5 V supply. 

 

   Vd = _________     Vr = _________   Fwd or Reverse Bias_____ 

 

 Red LED with short lead connected to (-) terminal of 5 V supply. 

 

   Vd = _________    Vr = _________     Fwd or Reverse Bias_____ 

 

 Red LED with short lead connected to (+) terminal of 5 V supply. 

 

   Vd = _________     Vr = _________    Fwd or Reverse Bias_____ 

 

In the space below, sketch each of these diodes, and below each sketch, draw the correct 

corresponding diode symbol.  Does the "bar" on the diode package match with the bar (cathode 

terminal) in the diode symbol?  Which lead of the LED, long lead or short lead (with the 

flattened rim), corresponds to the cathode terminal in the diode symbol?   
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2.  Diode Model Parameter Determination (Finding n and Is) 
We shall use a 1 kΩ resistor as a "current sensing" element, which is connected in series with a 

1N4148 small-signal diode (connected so the diode will be forward-biased) and your variable dc 

bench power supply, as shown in Figure 1. Record the DVM voltage measurements across the 

diode, and also across the current sensing resistor (Vd and Vr).  Use the Microsoft Excel 

spreadsheet program to make a table of your results.  Start by entering side-by-side columns for 

Vd and Vr.  Then, from the Vr column, calculate additional columns that display Id (in Amperes) 

and also the natural log of Id, ln(Id). Now vary your dc supply voltage so that you obtain data 

points corresponding to Vr = 20 V, 10 V, 5V, 2.5 V, 1.25 V, 0.625 V, 0.3125 V (or as close as 

you can come to these values.)  Please remember that Vr is the voltage across the 1 kΩ resistor, 

not the dc power supply voltage, which must be set slightly higher than Vr to overcome the diode 

junction drop. 

 

                          Figure 1.  Diode I-V Curve Measurement Circuit 

 

 
 

Repeat these measurements using a 1N4004 power diode and a Red LED. Attach this table 

(including you measurements for each of these three diodes) as "Exhibit A".  From your 

recorded data, list the observed "diode forward voltage drop" at at a forward diode current of 10 

mA for each of these three common types of diodes? 

 

 Small Signal Diode Forward Voltage Drop at 10 mA = ________  Volts 

 Power Diode Forward Voltage Drop at 10 mA = _____________  Volts 

            Red LED Forward Voltage Drop at 10 mA  =     _____________  Volts 

 

For your small-signal diode data, use Microsoft Excel (see Appendix A) to plot Vd vs. Id and 

also plot Vd vs. ln(Id).  Attach these two plots as "Exhibit B".  Which of these two plots appears 

to be more "linear"? _______ 

 

In the space below, start with the ideal diode equation 

 

                                Id = Is[exp(Vd/(n*Vt)) - 1],             where Vt = k*T / q 

 

  1 kΩ  

(+)  Agilent 34401A 6.5 

(-)   Digit Multimeter +  Vr   - 

+ 

Vd 

- 
Diode under test 

                + 

Agilent 

E3631A 

0-25V DC 

Pwr Supply 

                - 
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throw out the "-1" (go to the forward-bias approximation), and derive formulas for finding n and 

Is from the slope (m) and y intercept (b) of the linear least squares curve fit (linear regression) of 

the Vd vs. ln(Id) plot, which is of the form Vd = m*ln(Id) + b.  You may assume that the thermal 

energy per coulomb of charge is given by Vt = kT / q = 0.026 Volts, since our laboratory is at 

"room temperature”.   You should be able to show that  

 

                                                   Is = exp(-b / m)  and  n = m / Vt 

 

      Derivation of expressions for Is and n in terms of linear regression parameters m and b 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

First use the Microsoft Excel spreadsheet to perform a linear least squares regression analysis on 

the following PSPICE simulated data.  Follow the instructions in Appendix A. 

 

                                    Vr         Vd(D1N4148)      Vd(D1N4002)    

                                   ------------------------------------------------ 

                                   20 V            0.765 V             0.727 V 

                                   10 V            0.723 V             0.691 V 

                                     5 V            0.685 V             0.656 V 

                                   2.5 V           0.650 V             0.620 V 

                                   1.25 V         0.615 V             0.584 V 

                                   0.625 V       0.582 V             0.549 V 

             0.3125 V     0.549 V             0.513 V 

 

Use the Microsoft Excel spreadsheet to perform a linear least squares regression analysis on this 

simulated Vd vs. ln(Id) data for the two diodes indicated, which were taken from the PSPICE 

“Eval” library.  Attach your computer-generated EXCEL spreadsheet, as well as each of the two 

linear regression plots, as Exhibit C.  Fill in your regression results, and also calculate the 

corresponding n and Is values for each of the diodes right on the spreadsheet.  You MUST 

SHOW that your answers come out to n = 1.981 and Is = 7.809x10
-9

 A, with R
2
 = 0.998 for the 
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D1N4148 simulated diode, and n = 1.977 and Is = 1.439x10
-8

 A with R
2
 = 1.00 for the D1N4002 

simulated power diode.  If you cannot get your spreadsheet to give the correct answers with these 

simulated data, please get help!  No credit will be given for this entire laboratory if this check 

data cannot be properly analyzed in Exhibit  C! 

 

Once you have gotten the correct answers for the simulated data, repeat your analysis with the 

live data that you have collected for the three “real” diodes you recorded in Part A, be sure to 

include your R
2
 value, whose closeness to 1 indicates how reliably your measurements were.  

Include your spreadsheet as Exhibit D.  

 

 

1N4148   m = ___________    b = ___________    n = ______   Is = _________A_  R
2
 = ______ 

 

1N4004   m = ___________    b = ___________    n = ______   Is = _________A_  R
2 

= ______ 

 

Red LED m = ___________    b = ___________    n = ______   Is = _________A_  R
2 

= ______ 

 

3. Application of Diode Model to Solve for Vd and Id  

 
Use the n and Is values obtained above for your 1N4148 diode to (numerically) solve (using 

MAPLE or MathCad) for the diode current Id and the diode voltage Vd when it is placed in the 

circuit drawn below.  Start by finding the Thevenin Equivalent of what is seen looking out from 

the diode terminals.  Include your MAPLE or MathCad work as “Exhibit E”.  

 

 

 

R2

1 k +

R1
1 k

V1

10 V

R3

1 k
D2

D1N4148
Vd

-
 

 

 

 

Finally, build this circuit and compare the measured Id and Vd values (Id can be found by 

measuring the voltage across resistor R3) with the predicted ones using the diode model.  Fill in 

the summary table below: 

 

 

Measured Values   Predicted Values  % Error 

                                                                                     (Pred – Meas) / Pred  

  Id =___________   ____________  _______ 

  Vd =  _________      ____________  _______       

Id 
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Now assume that the forward-biased diode has a constant 0.7 V forward voltage drop, and 

therefore it simply acts like a 0.7 V battery.  Now re-calculate Id and compared with the 

predicted value for Id above.  Calculate the % error incurred by adopting this MUCH SIMPLER 

diode model. 

 

          Method 1                                      Method 2 

       Pred Id (from above)               Pred Id using simplified                        % Error 

       Using diode equation                Constant 0.7 V model               (Meth2-Meth1)/Meth1 

 

        Id = ___________                   Id = ____________                           _____________ 

 

4.  Using an LED as a “reciprocal” transducer 
 

In Part 1 you should have already observed that the LED lights when it is forward biased.  In this 

case, current (or voltage) is the stimulus or input variable, and light is the result, or output 

variable. Likewise, it turns out that, like most transducers, the LED can be used in the reciprocal 

sense; that is, light can be used as the stimulus (or input), and then voltage will be generated 

across the LED as the result, or output variable.  Investigate this phenomenon using your bench 

dc voltmeter and fill in the blanks below: 

 

 NO light (LED well covered by fingers):             Vd (anode w.r.t. cathode) = ________ V 

 

Moderate light (LED aimed toward room lights): Vd (anode w.r.t. cathode) = ________ V 

 

Bright light (overhead projector?):                        Vd (anode w.r.t. cathode) = _________V 
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Appendix A.  Plotting Data and Least-Squares Curve Fitting with Excel 2007 
 

1) Bring up Microsoft Excel (Start – All Programs – Microsoft Office - Microsoft Office Excel 

2007).  Enter the Vr values (20 V, 10 V, 5 V, 2.5 V, 1.25 V, 0.625 V, 0.3125 V) in the first 

column of the spreadsheet.  Label the top of each column, as shown in the example 

spreadsheet below.  From the Vr values, calculate the diode current values in Amperes (Id) 

in the 2nd column.  Do this by clicking on the first row of the Id column, and enter the 

equation  

                                                               =A2/1000 

where A2 identifies the location of the top entry in the Vr column, and this value is divided by 

the value of the 1000 ohm resistor.  You may then copy this entry into the remaining positions 

of the Id column.  Next, calculate the corresponding ln(Id) values in the 3rd column. Do this 

by typing the following equation into the first row of the ln(Id) column: 

                                                          =ln(B2) 

where B2 is the location of the top entry in the Id column.  You may then copy this entry into 

the remaining positions of the ln(Id) column.  Finally, enter the diode voltage (Vd) data in the 

4
th

 column. 

 

2) By holding down the left mouse button and dragging it downward, select the ln(Id) column.  

Next, hold down the Ctrl key and select the Vd column. Note that the leftmost column 

selected will go onto the horizontal axis of the plot.  Therefore, it is important to place the 

Vd column to the right of the ln(Id) column, so that the ln(Id) data goes on the horizontal 

axis and the Vd data goes on the vertical axis. 

 

3) Now click on the Insert tab and select Scatter.  Then select the scatter plot icon with the 

smooth lines drawn through the points.  The desired plot should appear with ln(Id) on the 

horizontal axis and Vd on the vertical axis, as desired.   

 

4) To add an appropriate plot title and both horizontal and vertical axis titles, click anywhere 

inside the chart (to select it), and then click on the Layout tab at the top of the screen.  Select 

Chart Title and enter it (in this case “Vd vs. ln(Id) Plot for 1N4148 Diode”.  In similar 

fashion click on the Layout tab once again, but this time select Axis Titles.  Label the 

vertical axis “Vd in volts” and label the horizontal axis “ln(Id), where Id is in Amperes”. 

Note that we cannot ascribe any units to the natural log of Id, ln(Id).  However we might as 

well point out that Id is in Amperes. 

 

5) The resulting scatter plot can be sized in the usual way by applying the mouse to the chart 

borders.  Likewise, the chart can be dragged out to any desired position on the spreadsheet.  

Likewise the axis labels and chart label can be dragged to any desired position within the 

chart area. 

 

6) To add least-squares linear curve fit (regression) trend line, LEFT CLICK on the data line 

in the plot so that the points on the line are highlighted.  Then left click on the Layout tab at 

the top of the page and select "Trendline".   Click on the “More Trendline Options” at the 

bottom of the list.  A “Trendline Options” box should appear. In the "Trend/Regression 

Type" box, click on "Linear".  Now click the "Options" tab.  Check the box labeled "Display 

Equation on Chart".  This equation is of the form y = mx + b, where “y” is the dependent 

variable on the vertical (in this case Vd), and “x” is the independent variable on the 
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horizontal axis (in this case ln(Id)).  Likewise, m is the slope of the line and b is the y-

intercept.   

 

7) Also check the box labeled “Display R
2
 value on chart”.  R is called the “linear correlation 

coefficient”, which varies between (0, 1). The closer to 1 it is, the better the linear curve fit 

is, and hence the more closely your data falls along a straight line.  Thus the closer the R
2
 

value is to one, the “better” your data is!  Hit the close button.  The linear curve fit equation, 

as well as the linear correlation coefficient can now be "dragged and dropped" wherever you 

would like them to be placed on the chart.   

 

Your spreadsheet should now look like the one shown below: 

 

    

 

 
 

        Vr Id(1N4148) ln(Id) Vd(1N4148) 

        
20 0.02 

-
3.91202 0.765 

         
10 0.01 

-
4.60517 0.723 

         
5 0.005 

-
5.29832 0.685 

         
2.5 0.0025 

-
5.99146 0.65 

         
1.25 0.00125 

-
6.68461 0.615 

         
0.625 0.000625 

-
7.37776 0.582 

         
0.3125 0.0003125 

-
8.07091 0.549 

         

             

             

             

             

             

             

             

             

             

             

              


